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Fiery Essential Driver for Windows

Fiery Essential Driver lets your applications communicate with your Fiery server and print documents.
When using Fiery Essential Driver, observe the following:

• Fiery Essential Driver has default presets for most applications and printers. You can easily change a preset if you
install a new printer option or want to set a specific feature.

• Print options and their settings let you access the special features of your printer.

• Some Fiery Essential Driver print options (document properties) are also available from your applications when
you print a job.

• In general, changing the Fiery Essential Driver print options from the Settings window or Devices and Printers
folder changes the global settings that apply to all jobs printed using the selected printer. You may have to also
select the same settings from the application, because application-specific settings may override the global
settings. Print settings selected within the application are generally in effect for the current session while you
have the application open.
When you print from applications that have application-specific options for full-bleed and scaling, we
recommend that you define these print option settings in the Fiery Essential Driver for most applications. For
Adobe applications, if the full-bleed and scaling option settings are made in the Print window of the application
and you do not set them in the Fiery Essential Driver to match the settings in the application, then it might
change the output scaling and the printed image.

For information about specific Fiery Essential Driver print settings and print options, contact your printer
administrator.

Command line installation of the Fiery Essential Driver

The Windows driver downloaded from WebTools now supports silent installation of the driver on any client. This
feature supports enterprise installation of the Windows driver through the various third-party deployment tools.
To view errors, select Event Viewer > Windows Logs > Application. PRNTDRV.EXE will be listed as the source of error.

Note: Error messages will also be displayed in the command window.
The following functionalities are supported:

• Launching the Fiery Essential Driver Installer Wizard

Note: To start the Fiery Essential Driver Installer Wizard, launch PRNTDRV.EXE either from the command line
or Windows Explorer.

• Printer driver and printer silent installation

• Listing of models that the driver package supports

• Listing of the locales that the driver package supports

Fiery Essential Driver for Windows
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• Driver package extraction

• Note: The final four functionalities listed are accessed by applying specific parameters to PRNTDRV.EXE from the
command line.

Note: For all functionalities, open the command window CMD.EXE in administrator mode. Once the command
window opens, change the folder to the directory where PRNTDRV.EXE exists.

Launching the Fiery Essential Driver Installer Wizard

Fiery Essential Driver Installer Wizard Setup.exe will be launched if it is in the driver package and no
parameters are passed to PRNTDRV.EXE, which can be accomplished by:

• Double-clicking PRNTDRV.EXE from the explorer

• Typing PRNTDRV.EXE in the command window

Note: Double-clicking PRNTDRV.EXE will not display the printer driver package extraction window. Instead, the
printer driver installation will continue and the Fiery Essential Driver Installer Wizard will be displayed.

Print driver and printer silent installation

Command: PRNTDRV.EXE /install [-i ipaddress/hostname] [-l locale] [-m model] [-p printername] [-q queue]

• -i specifies the IP address/hostname of the print server that the printer points to. It is up to the user to make
sure that the specified IP address/hostname belong to a valid print server. No checks will be made for their
validity. This parameter is required, and an error will be reported if it is missing.

• -l specifies the two-letter locale of the print driver that should be installed. If the print driver package supports
more than one language, then this parameter is required, and an error will be reported if it is missing. If the print
driver package is locale-specific, then this parameter will not be required because there will be only one driver
available to install within the driver package.

• -m specifies the model of the driver that should be installed. The driver package usually supports at least two
models of the print driver. This parameter is required, and an error will be reported if it is missing.

Note: The model name should be in double quotes.

• -p specifies the name of the printer. This parameter is optional, and if not specified, the printer name will be set
to the same name as the printer model.

Note: The printer name should be specified in double quotes.

• -q specifies the print queue that the printer should print to. It may be one of the Hold, Print or Direct queues or
the name of a virtual printer. It is up to the user to make sure that the specified print queue or virtual printer
exists on the server. This parameter is optional, and if not specified, the print queue will default to "print."

Listing of models the driver package supports

Command: PRNTDRV.EXE /listmodels [locale]

In order to list the models supported by the specified locale, the two-letter locale must be specified next to the /
listmodels switch. If the specified locale is invalid or not supported by the driver package, an error will be
reported. This parameter is required if the driver package supports more than one locale. If the driver package is
locale-specific (supports only one locale), then this parameter will be ignored.
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Listing of locales the driver package supports

Command: PRNTDRV.EXE /listlocales

Driver package extraction

Command: PRNTDRV.EXE /extract [path]

The [path] parameter is optional, and if not provided, the driver package will be extracted to the Prntdrvr folder,
which will reside in another folder with PRNTDRV.EXE. If the path is specified, then it needs to be absolute.

Uninstall the Fiery Essential Driver

You can uninstall the Fiery Essential Driver from a client computer.
The uninstall utilities can be installed and used locally from a client computer. You do not need to connect to the
Fiery Essential Driver before you use the software.
You can uninstall the Fiery Essential Driver using the Fiery Printer Delete Utility.

Fiery Printer Delete Utility

The Fiery Printer Delete Utility can be installed and used locally to uninstall Fiery Essential Drivers from a Windows
client computer. You do not need to connect to the Fiery server before you use the software.
The Printer Delete Utility must be installed on the Windows client computer to remove printer drivers.
The Fiery Printer Delete Utility can be downloaded from the Fiery website.

1 Go to the Download Center.

2 You must register before you can download the system software update and documentation. Click Submit to
submit your registration information.

3 Click the Application Software and Tools tab in the Download Center.

4 Select Fiery Driver from the Select Software list, choose Fiery Printer Delete Utility from the Select Version list,
and click Find.

5 Locate FieryPrinterDeleteUtility.zip in the list of results and click Download.

6 Click Accept to agree to the terms of the license agreement.

7 Double-click the FieryPrinterDeleteUtility.exe and follow the on-screen instructions.

Uninstall a Windows Fiery Essential Driver

The Windows Fiery Essential Driver can be uninstalled with the Fiery Printer Delete Utility.
1 Click Start > All Programs > Fiery > Printer Delete Utility.

The Printer Delete Utility window opens and shows all Fiery Essential Drivers found on the computer are listed.

Fiery Essential Driver for Windows
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2 Do one of the following:

• To delete a printer, select the check box next to the printer name and click Delete the Selected Printers.

• To delete all of the installed printer drivers, select the Delete All Printer Drivers check box, and click OK.

3 When you finish deleting printer drivers, click Exit.

Using command line instructions to delete printer drivers

You can use command-line functions for removal of the printer and corresponding printer driver on Windows.

Uninstall Windows printer drivers

You can use the Fiery Printer Delete Utility from the Command Prompt to remove a printer and corresponding
printer driver with command-line functions on a Windows operating system.
The latest version of the Visual C++ Redistributable package must be installed on the computer where the Fiery
Printer Delete Utility is running.

1 Install the Fiery Printer Delete Utility using WebTools.
a) Start your Internet or intranet browser and type the DNS name or IP address of the Fiery server.

b) Expand Software Downloads.

c) Click the Printer Drivers link under the Windows tab and follow the on-screen instructions to install.

d) Navigate to the local folder where the printer driver files were downloaded and double-click the Fiery Printer
Delete Utility folder.

e) Double-click setup.exe and follow the on-screen instructions to install the utility.

2 Start Command Prompt as an administrator on your Windows system and navigate to the path where the Fiery
Printer Delete Utility is installed.
It is installed in the \Program Files\Fiery\Applications3\PrinterDeleteUtility folder.

3 Type the following command: Start /wait Printer Delete Utility.exe [options]
The [options] can be any of the following:

-rmPrints Removes all the printers

-p \"\Printer1, Printer2\"\ Removes specified printers. Printer names must be separated by a comma and the complete list
should be enclosed within \"\ \"\.

-getInstalledPrinters Gets a list of all printers using Fiery Essential Drivers.
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Open the list of installed printers

How you navigate to the list of printers installed on a computer depends on the operating system.
1 Navigate to the devices and printers on your network.

The printers are displayed in the Printers & scanners tab or the Devices and Printers folder.

2 Do one of the following:

• Windows 11: From the desktop, right-click the Start button in the lower-left corner of the screen. Click
Settings. Click Bluetooth & devices and then select Printers & scanners.

• Windows Server 2022: From the desktop, right-click the Start button in the lower-left corner of the screen.
Click Settings. Click Devices and then select Printers & scanners.

• Windows Server 2019: From the desktop, right-click the Start button in the lower-left corner of the screen.
Click Settings. Click Devices and then select Printers & scanners.

• Windows 10/Server 2016: From the desktop, right-click the Start button in the lower-left corner of the screen.
Click Settings. Click Devices and then select Printers & scanners.

Note: Fiery Essential Driver supports all versions of Windows 10 including version 21H2 and earlier.

Fiery Essential Driver tab

The tab serves as the control center for all frequently used printing functions.
The Fiery Essential Driver tab contains all the presets that are specific to the printer. If you choose a factory preset,
the job prints according to the settings entered during Setup or the printer's default settings.

Note: You can also access and set some Fiery Essential Driver tab options from an application, and the application
settings might override settings made from Printing preferences.
In addition, some utilities, such as Command WorkStation, can override some print settings for a job. (See Fiery
Command WorkStation Help.)

Fiery Essential Driver groups

The Fiery Essential Driver groups print options by categories for easy access. Each group or tab contain options that
are related or complement each other.

• Presets - Contains presets to use in printing and the option to specify the number of copies for a job. Factory
presets are displayed in the Presets tab by default. For more information on available factory presets, see Fiery
Essential Driver presets on page 13.

• Preset settings - Contains additional settings for each preset and the option to specify the number of copies for a
job. The Preset settings tab allows you to edit presets to create custom presets.

• User Authentication - All information that may be required for user authentication.

Fiery Essential Driver for Windows
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• Preferences - Allows you to change between Predefined settings and Production settings in Fiery Essential
Driver.
For more information on Production settings, see Fiery Driver Help.

• About - Contains information on your current Fiery Essential Driver version. You can also view details about
your Fiery server when Two-Way Communication is turned on.

• Tools - All Fiery applications supported by the connected Fiery server.

Note: Two-Way Communication for your printer must be turned on for the Tools tab to display.

Open the Fiery Essential Driver tab

You can use the Fiery Essential Driver tab to select and create presets.
1 Open the folder that lists the installed printers. (See Open the list of installed printers on page 9.)

2 Do one of the following:

• In the Devices and Printers folder, right-click the desired printer icon and click Printing Preferences.

• In the Printers & scanners tab, click Manage and then click Printing preferences.

3 Click the Fiery Essential Driver tab.

Use Fiery Essential Driver to set options installed on the printer

To use the print options for the printer and the Fiery server appropriately, you must configure the Fiery server from
your computer for the options installed on the printer.
Two-Way Communication, when turned on, overrides any manual settings you made to the installable options. Two-
Way Communication also allows the Fiery Essential Driver to query the printer and retrieve the options that are
currently installed. The installed options are listed in the Installed Options list and the Fiery Essential Driver settings
are activated that depend on those options.
When you configure installable options manually, you must match the actual configuration of the printer. Otherwise,
the print options that appear in the Fiery Essential Driver might not match the print options that are actually
available.
You can also revert to the options’ default values.

Change options installed on a printer with Fiery Essential Driver

You must use Fiery Essential Driver to edit the installed options on the printer.

Note: You must manually turn off Two-Way Communication (clear the check box) to configure installed options.

Fiery Essential Driver for Windows
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Note: The User Account Control (UAC) feature is available on Windows operating systems supported by the Fiery
server. You must log on with Administrator privileges to add or change the installable options after the printer driver
is installed.

1 Open the folder that lists installed printers. (See Open the list of installed printers on page 9.)

2 For Windows computers with User Account Control, right-click the Fiery server icon, select Run as administrator,
and then select Printer properties or Properties.
The User Account Control window opens.
Select the User that has administrator privileges, type the password, and then click OK.

3 Right-click the desired printer icon, and then click Printer properties or Properties.

4 Click the Accessories (or Configuration, or Installable Options) tab to verify that the option you want to use is
available.

5 To retrieve the installed options from the printer itself, select Two-Way Communication, enter the IP address or
DNS name of the Fiery server connected to the printer, and then click Update.

6 To configure installed options manually, select an option in the Available Options list, and then click Add. To
revert to the installed options default settings, click Defaults.

Note: Make sure that the printer actually has the option installed.

7 To automatically update the installed options on the driver each time it opens, select Update Fiery Driver When
Opened.
This avoids conflicts between the selected settings when one or more of the installed options change or become
unavailable.

8 To receive e-mail notification of any errors that occurred during printing, select Enable E-mail Notification and
type the e-mail address to send the e-mail notification.
Enable E-mail Notification appears only if E-mail Service is turned on at Setup on the Fiery server. (See
Configuration and Setup, which is part of the user documentation set.)

9 Click Apply, and then click OK.
You must click OK for the printer driver to reflect the correct installable options.

Note: The installable options are not reflected correctly if you close the window by clicking Cancel or the Close
icon.

Change print settings with Fiery Essential Driver

You can change print settings for the current document or for all documents that you send from your computer.
Where you change a setting determines the scope of the change:

• Changes made from an application typically apply to documents printed while that application is open.

• Changes made in Printing preferences apply to the selected printer and all print jobs sent to that printer.
However, if you can set the same print option setting within the application, the application setting may override
the setting in Printing preferences.
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Note: If you use Printing preferences to change a print setting for a single document, remember to change the setting
back to its default value before printing other documents, if necessary, during the current application session.
Closing the application restores all settings to their default values in Printing preferences.
Some tasks require a specific method for changing settings. For example, you must make all changes to font settings
in Printing preferences, not from an application. Also, if your application does not let you change the settings, use
Printing preferences.

Change print settings for all documents sent from your computer

The Printing Preferences window lets you change the default print settings for all documents.
The application's Print window lets you override some default print settings for a document. If a print setting is
unavailable, you can make it available by changing the print settings for all documents sent from your computer.

Note: If you do not use the same settings for all print jobs, you can save each unique group of print settings as a
preset.

1 In your application, click File > Print or File > Print Setup, and then select the Fiery server as your printer.

2 Click the button that displays the Document Properties window.
The sequence of steps to open the Document Properties window varies according to the application.

3 Open the Fiery Essential Driver tab. (See Open the Fiery Essential Driver tab on page 10.)

4 Select the desired preset or create a custom preset for the print settings.

5 After you specify the print settings, click OK, and then click Print to send your print job.

Presets in Fiery Essential Driver

A preset is a collection of print settings in the Fiery Essential Driver that you can access at any time.
You can select a job preset in the Presets tab, or create a new preset based upon the current options set in Fiery
Essential Driver. All properties display the initial default settings. You can edit and save a preset to create a custom
preset.
There are two types of job presets:

• Factory presets - Presets available by default in the Fiery Essential Driver.
Factory presets can be edited and saved as a custom preset. However, you cannot modify a factory preset. For
more information on the available factory presets, see Fiery Essential Driver presets on page 13.

• Custom presets - Presets you can customize and add to the preset list in the Fiery Essential Driver.
Custom presets can be created from existing factory presets. For more information on creating custom presets,
see Create a preset in Fiery Essential Driver on page 13.
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Fiery Essential Driver presets

The Fiery Essential Driver presets contain print options that are related or complement each another. Factory presets
are available by default. You can also create custom presets that will appear in the Presets tab.

• Quick print - Prints jobs using the most commonly used job properties.

• Eco-friendly print - Prints jobs monochrome on both sides of the paper to save paper. The Eco-friendly print
preset only prints in black and white or grayscale.

• 2-sided print - Prints jobs on two sides of the paper.

• Watermark - All watermark properties that define the placement and style of the watermark.

• Booklet - Creates a simple booklet from your document.

Change the preset view

You can specify the presets displayed in the Presets tab.
1 Open the Fiery Essential Driver tab. (See Open the Fiery Essential Driver tab on page 10.)

2 In the Presets tab, select one of the following options to change the displayed presets:

• All presets

• Factory presets

• Custom presets

Work with presets in Fiery Essential Driver

You can create, edit, and delete presets. You can also revert to the default settings for a preset.

Note: The Presets file format is either .sav or .xml. For an .sav file, each preset is an individual file. For an .xml file, all
presets are in a single file. The Presets file is created specifically to a user.

Create a preset in Fiery Essential Driver

You can create a preset that contains commonly used print settings. Presets in Fiery Essential Driver are created by
editing a factory preset.
You save the preset on your local computer, and you cannot share it with others.

1 Open the Fiery Essential Driver tab. (See Open the Fiery Essential Driver tab on page 10.)

2 In the Presets tab, click the pencil icon in the upper-right corner of the preset you want to edit.

3 Click More and specify the print settings as desired.
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4 Click Save.

5 In the Save preset window, type a preset name and click Save.

Note: The name you type should be unique for each preset. The preset name must not already be used by another
preset.

Change the preset for all print jobs in Fiery Essential Driver

You can change the preset for all print jobs.
1 Open the Fiery Essential Driver tab. (See Open the Fiery Essential Driver tab on page 10.)

Note: When you access the Fiery Essential Driver tab from an application's Print window and select a preset, the
preset is used only for the current application session.

2 In the Presets tab, select a different preset.

3 From the Presets list, select a different preset.

Use a preset to print a job in Fiery Essential Driver

The Presets tab shows which, if any, presets are available for all print jobs. After you print a job using a preset, the
same preset is used until you select another preset.

Note: You cannot share presets between different Fiery Essential Drivers.

1 Open a document and click File > Print or File > Print Setup, and then select the Fiery server as your printer.

2 Click the button that displays the Document Properties window.
The sequence of steps to open the Document Properties window varies according to the application.

3 In the Presets tab, select a preset.

Note: You can select a factory preset or a custom preset. A custom preset must be created before it appears in the
Presets tab.

4 Click OK in the Document Properties window.

Edit a preset in Fiery Essential Driver

A preset includes most print options that you set in the Fiery Essential Driver tab. You can override a setting in the
Presets tab after choosing a preset, but must save the preset.
1 Open the Fiery Essential Driver tab. (See Open the Fiery Essential Driver tab on page 10.)

2 In the Presets tab, click the pencil icon in the upper-right corner of the preset you want to edit.

Note: You can edit a factory preset and save it as a custom preset. Click the Reset icon to change the print
settings to their default values.
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3 Change the print settings.

4 Click Save.

5 In the Save preset window, type a preset name and a description if you desire.

Note: You can a custom preset using the same name to replace an existing preset. For factory presets, the preset
name must not already be used by another preset.

6 Click Save.

Delete a preset in Fiery Essential Driver

You can delete a preset with in the Manage presets window in Fiery Essential Driver. Custom presets can be deleted,
but you cannot delete factory presets.

Note: To delete a preset, the preset must be unused.

1 Open the Fiery Essential Driver tab. (See Open the Fiery Essential Driver tab on page 10.)

2 In the Presets tab, select Manage presets from the menu.

3 Click the Delete icon.

4 Click Save.

Export or import custom presets in Fiery Essential Driver

You can export or import custom presets with the Fiery Essential Driver.
1 Open the Fiery Essential Driver tab. (See Open the Fiery Essential Driver tab on page 10.)

2 In the Presets tab, select Manage presets from the menu.

3 Do one of the following:

• Click the Import custom presets icon to import a preset in the Fiery Essential Driver.

• Click the Export custom presets icon to export each selected preset to a single file (for example
PresetName.sav).

4 Browse to a location to save or retrieve the Presets.xml file.

5 Browse to a location to save or retrieve the PresetName.sav file.

6 Click Save or Open.
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Use watermarks in Fiery Essential Driver

The Watermark feature of Fiery Essential Driver allows you to print text (independent of that provided by the
printing application) across the first page or on every page of a document.
You can define, save, and use the watermark definitions for all Fiery server printers and all documents. You can also
specify watermark settings when you print a document.

Note: Not all applications support watermark printing. Not all fonts, such as certain Japanese and Chinese fonts, are
printed in watermarks.

Print a job with a watermark

Watermarks are specific to a printer. You can set a watermark to print across the first page or on every page of a
document. If you do not specify the watermark to print on the first page only, then every page in the document
receives a watermark.
1 Open the Fiery Essential Driver tab (See Open the Fiery Essential Driver tab on page 10.

2 In the Presets tab, click the Watermark preset.

3 Select the desired watermark.

4 Specify the print settings as desired, and then print the document.

Enter login information

If the Fiery server requires user authentication for printing, you must enter your user name and password when you
use to print.

Note: The login can be your network domain\user name or a local user name. Check with your system administrator
about your system’s requirements.

1 Open the Fiery Essential Driver tab. (See Open the Fiery Essential Driver tab on page 10.)

2 Click the User Authentication icon.

3 In the User Authentication tab, clear the I'm a Guest check box.
If you do not have a Windows login, select the check box.

Note: The Fiery server must be configured to allow guest printing.

4 Do one of the following:

• Select the Use Windows Login check box to submit your Windows user name and password.

• Type your user name and password in the fields.

Note: The Use Windows Login check box might not appear, depending on the type of user authentication
configured on your computer.
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5 Click Authenticate to confirm that the Fiery server recognizes your user name, password, and privileges.

Note: Validation works only if Two-Way Communication is turned on.

6 Enter additional authentication details in the tab to the right of the User Authentication tab.

7 Specify the print settings as desired, and then print the document.

Change Fiery Essential Driver preferences

You can change the settings that appear in Fiery Essential Driver.
1 Click the Preferences tab.

2 Select Production settings.

3 Click OK.
The Printing Preferences window closes.

4 Open the Fiery Essential Driver tab. (See Open the Fiery Essential Driver tab on page 10.)

When the Printing Preferences window is reopened, your selected printer driver setting is displayed.

Manage PostScript files in Fiery Essential Driver

You can print to PostScript files, and create portable or Encapsulated PostScript (EPS) files. You can instruct Fiery
Essential Driver to print to a file from either Fiery Essential Driver or the application.

Set up to print to a PostScript file

You can set up to create PostScript files. This is useful if your application cannot print PostScript files.
1 Open the folder that lists the installed printers. (See Open the list of installed printers on page 9.)

2 Right-click the desired printer icon and click Printer properties or Properties.

3 Click the Ports tab.

4 Under the list of ports, select FILE.

5 Adjust any print options and printer controls, if necessary, before printing to a file.
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